Quick Guide to Implementing the SAP ERP Rapid-Deployment Solution for Employee and Manager Self Service
statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.
Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Caution Icon]</td>
<td>Caution</td>
</tr>
<tr>
<td>![Example Icon]</td>
<td>Example</td>
</tr>
<tr>
<td>![Note Icon]</td>
<td>Note</td>
</tr>
<tr>
<td>![Recommendation Icon]</td>
<td>Recommendation</td>
</tr>
<tr>
<td>![Syntax Icon]</td>
<td>Syntax</td>
</tr>
</tbody>
</table>

Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example text</strong></td>
<td>Words or characters that appear on the screen. These include field names, screen titles, pushbuttons as well as menu names, paths and options. Cross-references to other documentation.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Emphasized words or phrases in body text, titles of graphics and tables.</td>
</tr>
<tr>
<td><strong>EXAMPLE TEXT</strong></td>
<td>Names of elements in the system. These include report names, program names, transaction codes, table names, and individual key words of a programming language, when surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Screen output. This includes file and directory names and their paths, messages, source code, names of variables and parameters as well as names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>EXAMPLE TEXT</strong></td>
<td>Keys on the keyboard, for example, function keys (such as F2) or the ENTER key.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><strong>&lt;Example text&gt;</strong></td>
<td>Variable user entry. Pointed brackets indicate that you replace these words and characters with appropriate entries.</td>
</tr>
</tbody>
</table>
Contents
1 Solution Overview ................................................................. 7
2 Implementation Methodology for Rapid-Deployment Solutions ........... 7
3 System Requirements ............................................................ 7
3.1 SAP Software Component Installation Check ................................ 8
3.2 Release and Support Package Level ........................................ 8
3.2.1 Receiving the Software at the Correct SPS/SP Level .................. 9
3.2.2 SAP ERP Core Component Server 6.0 .................................... 9
3.3 SAP Best Practices Add-on and SAP Best Practices Solution Builder Add-on ........................................ 11
3.4 SAP Solution Manager ....................................................... 12
3.5 SAP Enterprise Extensions Sets and Enterprise Business Functions .... 13
3.6 Activating the Content Server Service ...................................... 15
3.7 SAP Notes and Messages ..................................................... 16
3.8 Troubleshooting ............................................................... 18
3.9 Related Documentation ...................................................... 18
4 Prepare for Implementation of SAP Rapid-Deployment Solution (System Administrator) ......................................................... 18
4.1 General Client Settings ...................................................... 18
4.2 Create System User for Content Activation ............................... 19
5 Prepare the System for Activating Business Content Scenarios (Activation Consultant) ................................................................. 20
5.1 Initial Check of System Readiness ........................................... 20
5.2 Check Content Prerequisite in the Client .................................... 20
5.3 Activation Language ......................................................... 21
5.4 User Settings for Activation .................................................. 21
5.4.1 Deactivate Info Dialog Box on Dynpro Size Check .................... 21
5.4.2 SAP Software Change Registration (SSCR): Developer Key .......... 22
5.4.3 Unicode Settings .......................................................... 22
5.4.4 Allow GUI Scripting ....................................................... 22
5.4.5 Set Decimal Notation and Date Format ................................... 23
5.4.6 Allow Default Actions ..................................................... 23
6 Implementation of Rapid-Deployment Solution Business Content .... 24
6.1 Select the SAP Solution Manager Template ............................... 24
6.2 Adjust the Process Scope in SAP Solution Manager ...................... 25
6.3 Manual Implementation of the Content ..................................... 26
6.4 Automated Implementation Using SAP Best Practices Solution Builder ................................................................. 26
6.4.1 Delivery of Automated Content ......................................... 26
6.4.2 Create Installation Folder for Content Activation ...................... 26
6.4.3 Getting the Solution Scope File ........................................... 26
6.4.4 Getting the Installation Data Files ......................................... 27
6.4.5 Import the Solution Scope File to the SAP System .................... 27
6.4.6 Upload Installation Data .................................................... 28
6.4.7 Set User Settings for Solution Builder ..................................... 28
6.4.8 Activate the Solution ....................................................... 29
6.4.9 Verify Web Dynpro ABAP eCATT Rendering Flag ..................... 30
6.4.10 Manual Interaction and Error Handling During Activation .......... 31
6.4.11 Optional: Changing the Package for Workbench Objects ............ 33
6.5 Uploading the Security Roles .............................................. 33

© SAP AG
Page 5 of 34
Quick Guide to Implementing the SAP ERP Rapid-Deployment Solution for Employee and Manager Self Service

Purpose

This quick guide helps consultants and customer project team members to implement the SAP ERP rapid-deployment solution for employee and manager self service (deployment option Microsoft SharePoint), based on SAP Best Practices. It outlines the steps required to technically implement this solution and directs you to more detailed documentation where applicable.

Before proceeding with this document, you must have:

- Defined the relevant scope
- Finalized technical prerequisites
- The required resources available (see involved roles).

The System Requirements section lists all the system prerequisites that have to be fulfilled by customers before implementation of the rapid-deployment solution can start.

The System Preparation section explains the tasks that need to be carried out in the systems by the system administrator and consultant to prepare for implementing the solution.

The Implementation section guides you through the steps of the technical implementation process. The solution scope for the implementation and configuration is subject to a scoping effort conducted beforehand.

This document does not provide a general overview and explanation of SAP Best Practices. For more information about content and positioning, see the related documentation and positioning of the content package.

This document is intended for

- System administrators and Basis consultants:
  - System set-up and preparation, including troubleshooting
- Activation/implementation consultants (can also be Basis consultants):
  - Activation/implementation of business content/scenarios
- Business consultants (who already have a sound knowledge of SAP Best Practices, including the tools and documentation):
  - Evaluation of business content/processes, including troubleshooting
  - As a source of FAQs and further information for extended usage of the package

The following sections are applicable to the roles required to successfully install the SAP ERP rapid deployment solution for employee and manager self service.

The Quick Guide for the second version of this rapid-deployment solution includes requirements for implementing Web Dynpro ABAP applications for MSS, delivered with the MSS Add-on 1.0, as well as Embedded Org Chart functionality deployed in MSS.
1 Solution Overview

The SAP ERP rapid-deployment solution for the employee and manager self service:
- Is based on SAP ERP 6.0, with Enhancement Package 5, Support Package Stack 8
- Is based on SAP Solution Manager 7.0, Enhancement Package 1
- Provides an accelerated deployment of the required configuration settings
- Delivers standard services for ESS, based on Web Dynpro ABAP, as supported by the solution scope and deployed in the NetWeaver Business Client
- Delivers standard services for MSS, based on Web Dynpro ABAP, via Manager Self-Service Add-on 1.0 and Embedded Organization Chart functionality, as supported by the solution scope and deployed in the NetWeaver Business Client
- Provides managers and employees with an easy-to-use application for self-services
- Is targeting customers that are aiming to implement simple self-service scenarios in a SharePoint environment

2 Implementation Methodology for Rapid-Deployment Solutions

Overall project guidance is provided by a specific step-by-step guide that streamlines implementation projects for rapid-deployment solutions, guiding project teams through the following phases:
- **Start**
- **Deploy**
- **Run**

The methodology supports project teams with templates, tools, questionnaires, and checklists, including guides and accelerators, to ensure that rapid-deployment solutions can be implemented quickly and pragmatically. Instructions for accessing the step-by-step guide specific to the SAP ERP rapid-deployment solution for employee and manager self service will be provided as part of the implementation process.

In addition, steps for implementing the back-end configuration required for Employee and Manager Self Services are included, both in respect of installing automated content and manual configuration steps (see also Configuration Guides for each building block in this package).

3 System Requirements

This section summarizes the prerequisites that are assumed to have been fulfilled by the customer, that is, in a phase preceding the actual implementation project.

⚠ Setting up the system landscape is not part of the delivery scope of the rapid-deployment solution.

The customer is expected to provide the system landscape with the required software components already installed so that the project team can implement and configure the scope of the rapid deployment of SAP ERP rapid-deployment solution for employee and manager self service. During this phase, SAP can be consulted for advice on aspects of the system landscape and the components required. The target SAP Application Server (AS) must be installed with the Support Package Stack (SPS) specified in this section and the SAP Notes as specified in detail in the section SAP Notes and Messages in this guide.
System Requirements:

- EhP 5 for SAP ERP 6.0, (ECC 6.0 EhP5, SPS8)
- SAP Solution Manager 7.0 EhP1
- Active Directory Server
- Microsoft SharePoint 2010

Functional Prerequisites

- Single Sign-On on SAML 2.0
- Adobe Document Services (ADS)
- In Adobe Reader, under edit preferences, under JavaScript, enable Acrobat JavaScript
- In Adobe Reader, under edit preferences under JavaScript Security, enable global object security policy

Client Prerequisites

- Adobe Reader 9
- Adobe Flash Player 9
- PC compatible with NetWeaver 7.02 PAM
  - See: www.service.sap.com/pam

⚠️ For SAP GUI: Ensure that you have installed the latest version of SAP GUI and the SAP Scripting Engine. Older versions might result in activation errors.

The Software Requirements document lists all software components and release levels required, which you can access in the step-by-step guide: Start → Confirm Installation.

Before activating a rapid-deployment solution, SAP ERP must be installed up to the specific SAP Support Package Stack with the correct SAP Notes applied, as specified in the section SAP Notes and Messages in this guide.

### 3.1 SAP Software Component Installation Check

Before the rapid deployment of SAP ERP rapid-deployment solution for employee and manager self service can be executed, the SAP project team performs a check of the software installation based on the requirements provided in this guide. Depending on the result, the SAP project team advises the customer on any missing steps that need to be performed.

For this installation check, a checklist provides guidance and technical checkpoints regarding general and specific pre-delivery requirements. The checklist also indicates the party in charge of addressing a specific item, that is, the customer or SAP.

You can access the Pre-delivery Requirements and Checklist in the step-by-step guide: Start → Prepare Project.

### 3.2 Release and Support Package Level

The deliverables of the SAP ERP rapid-deployment solution for employee and manager self service were developed and tested in a system landscape with specific release and Support
Package Stack (SPS) levels. If the SPS level in your system is different, errors might occur during the activation. You may be able to perform the activation activities manually using the configuration guides, but errors may still occur.

⚠️

Make sure your system meets the minimum SPS level requirements. If your system has an exceptional SPS level compared to the rapid-deployment solution requirements, only LIMITED SUPPORT can be provided.

If you need a higher SPS level in your system, for example, because of additional functionality, FIRST import and activate the rapid-deployment solution content and the best practices add-ons based on the SPS levels as mentioned below. THEN update your system to the target SPS level.

No support can be provided in case of errors in Microsoft Sharepoint.

The Support Package Stack levels relevant for the SAP ERP rapid-deployment solution for employee and manager self service are listed together with the required components in section 3.5 below.

### 3.2.1 Receiving the Software at the Correct SPS/SP Level

For delivery of the software, an installation number and a corresponding license agreement are required. An S-USER is required to order software in the Software Catalog or download from SAP’s Software Distribution Center within SAP’s Service Marketplace (SAP’s SWDC in SMP). You can only order unrestricted SAP software. Contact the SAP contract department to ask for a physical shipment or create a customer message on component XX-SER-GEN-CONTR.

Use the Maintenance Optimizer within your SAP Solution Manager to download SPSs. You can also select relevant, individual Support Packs (SPs) manually from the SWDC in the SMP:


⚠️

Only the current Service Release (SR) is delivered to SAP customers / partners via SAP’s SWDC in SMP and standard delivery (for example, Software Catalog). If you encounter the situation that the required SPS for correct packages activation is based on SPS level LOWER than the current SR, the request for the necessary SPS is handled via a customer message. For details, see the SAP Note 925690 - Standard Ordering Procedures for SAP Software:

https://service.sap.com/sap/support/notes/925690

### 3.2.2 SAP ERP Core Component Server 6.0

You can find detailed information for SPS definition for the SRs of SAP ERP, in SAP Note 774615 – Support Package levels of ERP/ECC installations/upgrades.

The rapid-deployment solution SAP ERP for employee and manager self service focuses on the SAP ECC Server ABAP. In order to provide a standardized installation process, a complete installation of the ABAP part of SAP enhancement package 5 for SAP ERP 6.0 is required. A Microsoft Sharepoint 2010 instance should be available as well.

Detailed information regarding the installation of enhancement package 5 for SAP ERP 6.0 can be found in SAP Note 1298878.

To download SAP enhancement package 5, go to the Software Distribution Center (SWDC) on SAP Service Marketplace.
The following software components are required in their respective SPS levels for the SAP ERP rapid-deployment solution for employee and manager self-service:

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Release</th>
<th>SPS/SP Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Basis 7.02 (SAP_BASIS)</td>
<td>702</td>
<td>0011</td>
<td>SAP Basis Component</td>
</tr>
<tr>
<td>SAP ABA 7.02 (SAP_ABA)</td>
<td>702</td>
<td>0011</td>
<td>Cross-Application Component</td>
</tr>
<tr>
<td>PI Basis 7.02 (PI_BASIS)</td>
<td>702</td>
<td>0011</td>
<td>Basis Plug-In</td>
</tr>
<tr>
<td>SAP Web UIF 7.1 (WEBCUIF)</td>
<td>701</td>
<td>0008</td>
<td>SAP WEBCUIF 701</td>
</tr>
<tr>
<td>SAP BS Foundation 7.02 (SAP_BS_FND)</td>
<td>702</td>
<td>0009</td>
<td>SAP Business Suite Foundation</td>
</tr>
<tr>
<td>SAP ERP 6.0</td>
<td>6.0</td>
<td></td>
<td>SAP 6.0</td>
</tr>
<tr>
<td>SAP ERP Enhancement Package</td>
<td>EhP5 for SAP ERP 6.0</td>
<td>SPS8, min.</td>
<td>SAP Enhancement Package 5 for SAP ERP 6.0</td>
</tr>
<tr>
<td>SAP_HR</td>
<td>604</td>
<td>0047</td>
<td>Human Resources</td>
</tr>
<tr>
<td>EA_HR</td>
<td>605</td>
<td>0024</td>
<td>SAP Enterprise Extension HR</td>
</tr>
<tr>
<td>EA-HR_MSS</td>
<td>1.0</td>
<td>0003</td>
<td>EA-HR_ Manager Self Service 1.0</td>
</tr>
<tr>
<td>Adobe Reader</td>
<td>9 &amp; above</td>
<td></td>
<td>Adobe Reader, Adobe Flash Player</td>
</tr>
<tr>
<td>EMBEDDED_OR_GCHART</td>
<td>605</td>
<td>0005</td>
<td>Embedded Org Chart</td>
</tr>
</tbody>
</table>

The required software components and SPS levels are usually downloaded using the Maintenance Optimizer of SAP Solution Manager. If you need to download the software manually from the Software Distribution Center on Service Marketplace, follow the path below:

**Installation:**

https://service.sap.com/swdc ➔ Installations and Upgrades ➔ Browse our Download Catalog ➔ SAP Application Components ➔ SAP ERP.

**Support Packages:**

The combination of the rapid-deployment solution for SAP ERP employee and manager self service with other SAP Best Practices packages and/or predefined and rapid-deployment solution packages may require a complete update of all ABAP software components of enhancement package 5 for SAP ERP 6.0.

As outlined in SAP Note 1064635, SPS levels for SAP ERP are synchronized throughout all enhancement package versions. Software components and addons not used within an enhancement pack should have the SP level assigned to the concurrent SPS of SAP ECC 6.00.

For an overview of all software components and their Support Package levels combined in the various SAP ERP Support Package Stacks, see SAP Note 1386389. You can also find information about software components and a typical landscape in the Software Requirements document. See the step-by-step guide: Start → Confirm Installation.

### 3.3 SAP Best Practices Add-on and SAP Best Practices Solution Builder Add-on

The following SAP Best Practices Add-ons must be imported into the system:

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Release</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP-ERP (1)</td>
<td>6.05</td>
<td>Vx*</td>
<td>SAP Best Practices All-in-One based on EhP5. This Add-on contains the SAP Best Practices technical framework (for example, BC-sets, eCATTS, print programs).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>*Use the latest version as outlined in SAP Note 1301301 Release Strategy for SAP Best Practices Package ABAP Add-ons.</td>
</tr>
<tr>
<td>BP-SOLBLD (1)</td>
<td>7.0</td>
<td>Vx*</td>
<td>Best Practices Solution Builder. This Add-on contains the SAP Best Practices Solution Builder program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For more information, see the document Importing SAP Best Practices Add-Ons (ADDONINS.PDF) on the configuration DVD.</td>
</tr>
<tr>
<td>BP-CANW</td>
<td>7.0</td>
<td>Vx*</td>
<td>Technical add-on; facilitates handling of eCATT and BC set objects.</td>
</tr>
</tbody>
</table>

(1) Additional and detailed information is listed in the document Importing SAP Best Practices Add-Ons (ADDONINS.PDF) on the configuration CD.

To download the SAP Best Practices ERP Add-ons, go to the SAP Software Download Center (SWDC) on the SAP Service Marketplace: https://service.sap.com/swdc, then choose Installations and Upgrades → Browse our Download Catalog → SAP Best Practices → SAP BP BASELINE PACKAGES → BASELINE PACKAGE – V1.-V2.605 → Installation. From the Downloads area, select the Download Object ‘Config: SAP Business All-in One’.

To activate the SAP Best Practices Solution Builder:

1. Run the following activity:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SICF</th>
</tr>
</thead>
</table>
2. On the **Maintain Services** screen, select **Execute** for the defaulted Hierarchy Type SERVICE, Language ENGLISH.

3. On the **Maintain service** screen, expand the **Virtuelle Hosts / Services** node as follows and activate the services listed below:

<table>
<thead>
<tr>
<th>Virtuelle Hosts/ Services</th>
<th>Status</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default_host &gt; sap &gt; public &gt; myssocntl</td>
<td>Active</td>
<td>Set the MYSAPSSO2 Cookie According to mysapsso2 Header Field</td>
</tr>
<tr>
<td>Default_host &gt; sap &gt; bc &gt; bsp &gt; smb &gt; sc_scoping_tool</td>
<td>Active</td>
<td>BP Scoping Tool</td>
</tr>
</tbody>
</table>

4. On locating the services (or relevant nodes), from the navigation menu select **Service/Host > Activate**.

5. The system displays an informational dialog box. Choose **Continue**.

6. Choose **Back** to navigate back to the **SAP Easy Access** screen.

---

**Regular Updates Technical Environment**

The technical add-ons provided by SAP Best Practices form the technical environment required for the automated implementation of your SAP Best Practices version with the SAP Solution Builder. This technical framework is continuously updated providing enhanced, fixed, or additional technical objects required for the technical implementation process.

SAP Best Practices therefore offers updated versions of the add-ons on a regular basis. Each updated add-on replaces the previous version in your system. For more information about the currently available versions of the add-on BP-ERP and the add-on BP-SOLBLD, see SAP Note 1301301 (The relevant content and execution of SAP Note 1301301 is included in the section **SAP Notes and Messages** of this document.)

Since the solution scope file and the most current installation data files always correspond to the current technical add-ons, you always need to make sure the most current versions are in your system before the technical implementation of your SAP Best Practices version starts.

The update of the technical framework has no impact on scope or business content of your SAP Best Practices version as it is described in the respective documentation.

---

**3.4 SAP Solution Manager**

An SAP Solution Manager system is required to implement the SAP ERP rapid-deployment solution for employee and manager self service. In general, SAP Solution Manager is required to install and manage maintenance certificates, enhancement packages, and upgrades. In the context of SAP rapid-deployment solutions, the implementation content is delivered in the form of SAP Solution Manager templates.

It is assumed that a productive SAP Solution Manager system (7.0 or higher) is available in the customer’s system landscape: if the customer is already using other SAP products (for example, SAP ERP), SAP Solution Manager should already be present in the system landscape.

<table>
<thead>
<tr>
<th>Product</th>
<th>Product Version</th>
<th>Component</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager Content</td>
<td>ST-RDS 100 plus latest SP level</td>
<td>ST-RDS</td>
<td>Required implementation content</td>
</tr>
<tr>
<td>SAP Solution</td>
<td>SAP enhancement</td>
<td>ST</td>
<td>Required</td>
</tr>
</tbody>
</table>
Manager | package 1 for SAP Solution Manager 7.0 SP18 or higher

If the SP is lower than 24, access the note 1579267.
Or use SAP Solution Manager 7.1 SP01 or higher

For more information about SAP Solution Manager, see the SAP Library documentation for SAP Solution Manager at http://help.sap.com -> SAP Solution Manager, or at http://service.sap.com/solutionmanager.

### 3.5 SAP Enterprise Extensions Sets and Enterprise Business Functions

#### Use

After SAP ERP has been installed, the following extension sets need to be activated before you start activation of the rapid-deployment solution for SAP ERP employee and manager self service.

![Warning](image)

Activating enterprise extensions, business functions, and business function sets makes permanent changes to your system and cannot be undone. For more information about the impact, see the documentation of the related extension or business function.

#### Procedure

1. Run the following activity:

<table>
<thead>
<tr>
<th>IMG Menu</th>
<th>Activate Business Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>SFW5</td>
</tr>
</tbody>
</table>

7. In the Security Information pop-up window, the message “Caution! Only reversible business functions can be deactivated. For this reason, activate only required business functions. In case of doubt, read the corresponding documentation.” Select Continue to proceed with caution.

8. On the Switch Framework: Change Business Function Status screen, select each of the following entries (by selecting the Planned Status column) and then choose the Activate Changes pushbutton:

<table>
<thead>
<tr>
<th>Enterprise Extensions</th>
<th>Planned Status</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>EA-HR</td>
<td>On</td>
<td>Human Capital Management extension. This will ensure that all of the required configuration nodes for this component are visible in the IMG.</td>
</tr>
<tr>
<td>EA-TRV</td>
<td>On</td>
<td>Travel Management Extension. As above.</td>
</tr>
<tr>
<td>Enterprise Business</td>
<td>Planned</td>
<td>Remarks</td>
</tr>
</tbody>
</table>

© SAP AG  Page 13 of 34
<table>
<thead>
<tr>
<th>Functions</th>
<th>Status</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA_HAP_CI_1</td>
<td>On</td>
<td>CA, Evaluations, Appraisals, and Surveys 01</td>
</tr>
<tr>
<td>FIN_TRAVEL_1</td>
<td>On</td>
<td>Travel Management</td>
</tr>
<tr>
<td>FIN_TRAVEL_2</td>
<td>On</td>
<td>Travel Management 2</td>
</tr>
<tr>
<td>FIN_TRAVEL_3</td>
<td>On</td>
<td>Travel Management 3</td>
</tr>
<tr>
<td>HCM_ASR_CI_1</td>
<td>On</td>
<td>HCM, Administrative Services 01 (EhP2)</td>
</tr>
<tr>
<td>HCM_ASR_CI_2</td>
<td>On</td>
<td>HCM, Administrative Services 02 (EhP4)</td>
</tr>
<tr>
<td>HCM_ASR_CI_3</td>
<td>On</td>
<td>HCM, Administrative Services 03 (EhP5)</td>
</tr>
<tr>
<td>HCM_ECM_CI_1</td>
<td>On</td>
<td>HCM, Enterprise Compensation Management 01</td>
</tr>
<tr>
<td>HCM_ECM_CI_2</td>
<td>On</td>
<td>HCM, Enterprise Compensation Management 02</td>
</tr>
<tr>
<td>HCM_ERC_CI_1</td>
<td>On</td>
<td>HCM, SAP E-Recruiting 1</td>
</tr>
<tr>
<td>HCM_ERC_CI_2</td>
<td>On</td>
<td>HCM, SAP E-Recruiting 2</td>
</tr>
<tr>
<td>HCM_ERC_CI_3</td>
<td>On</td>
<td>HCM, SAP E-Recruiting 3</td>
</tr>
<tr>
<td>HCM_ERC_CI_4</td>
<td>On</td>
<td>HCM, SAP E-Recruiting 4</td>
</tr>
<tr>
<td>HCM_ESS_CI_1</td>
<td>On</td>
<td>HCM, SAP E-Recruiting Search Functions 1</td>
</tr>
<tr>
<td>HCM_ESS_WDA_1</td>
<td>On</td>
<td>HCM, ESS for Personal Information</td>
</tr>
<tr>
<td>HCM_HIRE_INT_CI_1</td>
<td>On</td>
<td>HCM, Hire Integration 1</td>
</tr>
<tr>
<td>HCM_MSS_ERC_CI_1</td>
<td>On</td>
<td>HCM, MSS for SAP E-Recruiting</td>
</tr>
<tr>
<td>HCM_MSS_WDA_1</td>
<td>On</td>
<td>HCM, Manager Self-Service on Web Dynpro ABAP</td>
</tr>
<tr>
<td>HCM_NWBC_ROLES</td>
<td>On</td>
<td>HCM, Roles for SAP NetWeaver Business Client</td>
</tr>
<tr>
<td>HCM_OSA_CI_1</td>
<td>On</td>
<td>HCM, Performance Management 01</td>
</tr>
<tr>
<td>HCM_OSA_CI_2</td>
<td>On</td>
<td>HCM, Performance Management 02</td>
</tr>
<tr>
<td>HCM_PD_UI_1</td>
<td>On</td>
<td>HCM, PD UI Visualization 01 (Reversible)</td>
</tr>
<tr>
<td>HCM_TMC_CI_1</td>
<td>On</td>
<td>HCM, Core Processes in Talent Management</td>
</tr>
<tr>
<td>HCM_TMC_CI_2</td>
<td>On</td>
<td>HCM, Core Processes in Talent Management 02</td>
</tr>
</tbody>
</table>

9. The system displays an informational dialog box. Choose Continue.
10. Choose Back to navigate back to the SAP Easy Access screen.
11. Run the following activity:

<table>
<thead>
<tr>
<th>IMG Menu</th>
<th>Not Applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>SICF</td>
</tr>
</tbody>
</table>

12. From the Maintain Services screen, select Execute for the defaulted Hierarchy Type SERVICE, Language ENGLISH.
13. On the Maintain service screen, locate the following services to be activated (the services can either be selected individually or by specific nodes, for activation):
14. On locating the services (or relevant nodes), from the navigation menu select Service/Host > Activate.

15. The system displays an informational dialog box. Choose Continue.

16. Choose Back to navigate back to the SAP Easy Access screen.

### 3.6 Activating the Content Server Service

If the activation of the Content Server Service has already been executed, you do not need to execute the following steps. This service is to allow the pictures to be visible in Self Services for both the employee and the manager.

1. Run the following activity:

<table>
<thead>
<tr>
<th>Menu</th>
<th>SAP Easy Access Menu → Tools → Administration → Administration → Network → HTTP Service Hierarchy Maintenance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>SICF</td>
</tr>
</tbody>
</table>

2. From the Maintain Services screen, select Execute for the defaulted Hierarchy Type SERVICE, Language ENGLISH.
3. In the group box Filter for Calling ICF Hierarchy, select SERVICE as the hierarchy type and choose Execute.

4. Expand the tree under Virt.Hosts / Services: default_host → sap → bc.

5. Double-click the service content server.

6. The input template Create/Change a Service is displayed.

7. Choose the Logon Data tab page, and enter a user (and password) of the type Service.

   ! **Warning:**
   This user does not require any profiles or roles.

8. Save your changes.

9. Activate the contentserver service by selecting the service in the list of services and choosing Server/Host → Activate from the menu.

### 3.7 SAP Notes and Messages

An SAP Note is available to resolve any issues that arise after shipment of this rapid-deployment solution (and hence of this document).

> ! **Warning:**
> All SAP Notes must be applied to the system using the SAP Note Assistant. All SAP Notes mentioned below must have the implementation status ‘Completely implemented’. Some SAP Notes require manual action before you set the status to Completely Implemented.

To avoid activation errors as a result of generating loads, you must perform a mass generation using transaction SGEN, as described in the SAP Note 481548.

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1674342</td>
<td>SAP ERP rapid-deployment solution for employee and manager self service</td>
<td>SV-RDS_HCM</td>
<td>General Info</td>
<td>Always check the SAP Note for SAP ERP rapid-deployment solution for the employee and manager self service for updates on the implementation.</td>
</tr>
</tbody>
</table>

The following SAP Notes must be implemented (if not stated otherwise in the SAP Note mentioned above):

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1582553</td>
<td>Release Strategy for the ABAP Add-On EA-HR_MSS 1.0</td>
<td>BC-UPG-ADDON</td>
<td></td>
<td>Release information for the add-on</td>
</tr>
<tr>
<td>1301301</td>
<td>Release Strategy for SAP Best Practices Package ABAP Add-ons</td>
<td>SV-SMB-AIO-BP</td>
<td>Activation</td>
<td>SAP Note 1301301 refers to other SAP Notes. Always check the referenced Notes and follow the instructions.</td>
</tr>
<tr>
<td>SAP Note #</td>
<td>Description</td>
<td>Component</td>
<td>Area</td>
<td>Remark</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1588269</td>
<td>Solution Builder</td>
<td>BP-SOLBLD 70Vx</td>
<td></td>
<td>The corrections for the add-on are attached to this add-on specific Note. Always apply the correction transport for the corresponding add-on.</td>
</tr>
<tr>
<td>783499</td>
<td>Incorrect framework synchronization</td>
<td>PA-PA-XX</td>
<td></td>
<td>Avoidance of data inconsistency errors between front and back-end applications. Requires manual setting of switch in T77S0.</td>
</tr>
<tr>
<td>1567982</td>
<td>Installation of Add-On EA-HR_MSS 1.0</td>
<td>BC-UPG-ADDON</td>
<td></td>
<td>Installation and prerequisites guidance for the add-on</td>
</tr>
<tr>
<td>1582553</td>
<td>Release Strategy for the ABAP Add-On EA-HR_MSS 1.0</td>
<td>BC-UPG-ADDON</td>
<td></td>
<td>Release information for the add-on</td>
</tr>
<tr>
<td>1588625</td>
<td>Release information on Manager Self Service Add-On 1.0</td>
<td>CA-MSS-HCM</td>
<td></td>
<td>Information about the add-on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>In addition, clients must check all available Notes for the component area CA-MSS-HCM and ensure these are applied as appropriate for this add-on.</td>
</tr>
<tr>
<td>1488244</td>
<td>Missing MIME files for Organization Chart Visualization</td>
<td>EP-PCT-MGR-HR</td>
<td></td>
<td>Additional information on installing the add-on</td>
</tr>
<tr>
<td>1485853</td>
<td>Installation of EMBORGCH 605</td>
<td>BC-UPG-ADDON</td>
<td></td>
<td>Installation and prerequisites guidance for the add-on</td>
</tr>
<tr>
<td>1433225</td>
<td>Org Chart Visualization in MSS</td>
<td>EP-PCT-MGR-HR</td>
<td></td>
<td>Additional information on installing the add-on</td>
</tr>
</tbody>
</table>
3.8 Troubleshooting
If errors occur during the installation process, proceed as follows:
1. Check for troubleshooting notes in the step description of the configuration guide.
2. Check any issue is not related to security authorization issues.
3. Log on to SAP Service Marketplace and search for problem-related SAP Notes.

If the problem persists, proceed as follows:
- Create a customer message for component SV-RDS-HCM only if the problem relates to the pre-configuration of the SAP ERP rapid-deployment solution for employee and manager self-service.
- If the problem is a general one, indicate the relevant SAP application component.

3.9 Related Documentation
In addition to the accelerators linked to the step-by-step guide for this rapid-deployment solution and the Best Practices DVD mentioned above, further documentation on Best Practices can be found at http://service.sap.com/bestpractices and http://help.sap.com/bestpractices.

4 Prepare for Implementation of SAP Rapid-Deployment Solution (System Administrator)
The following section describes the activities that have to be performed by the system administrator in preparation for activating the SAP rapid-deployment solution business content in the system.

4.1 General Client Settings
To check and maintain the client settings in your system, use transaction code SCC4.
- **Client Role:**
  The system must not have any clients with a *productive* role. If the system contains a productive client, extension sets cannot be activated as required. Additionally, the content
cannot be activated automatically in a productive client using the SAP Best Practices Solution Builder because BC sets cannot be activated in the productive system.

- **Changes and Transport for Client Specific Objects - Automatic recording of changes**: In order to activate content for rapid-deployment solutions, automatic recording of changes is required. This indicator means that all changes are automatically recorded in a change request. These same transports will then be released to the test environment and finally to the production environment.

- **Cross Client object changes - Changes to repository and cross-client customizing allowed**: When a rapid-deployment solution is activated, cross-client objects are created. Cross-client functions include all cross-client Customizing objects (such as the factory calendar, definition of price list conditions, printer controls). In addition, they include all objects within the SAP Repository (such as reports, module pools, screens, Data Dictionary, and so on).

  If you have not configured the setting as described (*Changes to Repository and cross-client Customizing allowed*), you will be asked whether these settings should be defined automatically by Solution Builder when the package is activated. If you reject the required changes prompted by Solution Builder, activation cannot be executed automatically.

### 4.2 Create System User for Content Activation

**Use**

In this activity, you create a user to activate the scope of the rapid-deployment solution. However, this package does not supply separate Customizing settings or setup roles (in accordance with the security guideline). Instead, you should use the functions provided in *Role Maintenance* (transaction PFCG). Here, you can define a role that matches your individual IMG project and contains all of the authorizations you need to access the IMG activities required for the rapid-deployment solution scope. For more information about building a role for a Customizing project, see the documentation for transaction PFCG and the accelerator Consultant and End User Security in the step-by-step guide *Start > Prepare Project*.

Ideally, a broad authorization profile will be required to avoid a user encountering issues during activation: you should restrict the rights of the user according to your internal authorization guidelines. However, if the authorization profile assigned is not sufficiently wide-ranging, issues would need to be resolved on a case-by-case basis, during activation, which may be time consuming. You can, of course, use transaction SU53 to retrieve information about missing authorizations and extend the authorization data as necessary.

As soon as the the rapid-deployment solution content has been activated and validated, adjust the authorizations you granted to the system user who performed the activation steps. This is necessary for security reasons to prevent the system user from abusing the authorizations.

**Procedure**

1. To carry out the activity, choose:

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>Tools → Administration → User Maintenance → Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>SU01</td>
</tr>
</tbody>
</table>
2. In the User field on the User Maintenance: Initial Screen, enter <User-ID> and choose Create.
3. Choose the Address tab page.
4. Make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last name</td>
<td>&lt;Last name of the user&gt;</td>
<td></td>
</tr>
<tr>
<td>First name</td>
<td>&lt;First name of the user&gt;</td>
<td></td>
</tr>
</tbody>
</table>

5. Choose the Logon Data tab page.
6. Make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>&lt;initial password&gt;</td>
<td></td>
</tr>
<tr>
<td>User type</td>
<td>Dialog</td>
<td></td>
</tr>
</tbody>
</table>

7. Choose the Defaults tab page.
8. Make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon language</td>
<td>EN</td>
<td></td>
</tr>
<tr>
<td>Decimal notation</td>
<td>1,234,567.89 (or the standard notation for your country)</td>
<td></td>
</tr>
<tr>
<td>Date format</td>
<td>MM/DD/YYYY (or as required)</td>
<td></td>
</tr>
</tbody>
</table>

9. Choose the Roles tab page.
10. Enter the user role you created that contains the necessary authorization profile.

💡 Make sure that this complies with your internal security guidelines (see above).

**Result**

You have created a user to activate the rapid-deployment solution content.

## 5 Prepare the System for Activating Business Content Scenarios (Activation Consultant)

The following section describes the activities that have to be performed by the responsible consultant in preparation for activating the SAP rapid-deployment solution business content in the system.

### 5.1 Initial Check of System Readiness

You should check whether your system administrator has applied the correct SPS level as outlined above in the section Release and Support Package Level.

In addition, ensure that the system administrator has also completed all the activities described in the section System Preparation for Implementation of SAP Rapid-Deployment Solution (System Administrator).

Continue with the following steps only if these prerequisites are met.

### 5.2 Check Content Prerequisite in the Client

The RDS for SAP ERP employee and manager self service configures the self service scenarios available in the standard SAP business functions. It does however, not configure the business
process. For instance: Leave request is configured as a self service process, but the necessary Time Management configuration needed to generate absences or work schedules, is not configured. It is assumed that the data and configuration needed (i.e. Personnel Administration, Organization Management, Talent Management) for self services is available in the customer system.

5.3 Activation Language
Make sure that your logon language is always English (and NOT your local language) for all activation activities.

5.4 User Settings for Activation
The following user settings are a prerequisite for activating the rapid-deployment solution content. By specifying the settings in advance, you can avoid unnecessary errors and delays during the activation process.

⚠️ We recommend that only one user ID be used to activate the SAP rapid-deployment solution content as changing ownership of the activation once it is in process can be confusing and lead to issues.

⚠️ Make sure that you have only one single SAP GUI session running when you activate the SAP rapid-deployment solution content. If you are running several SAP GUI sessions, some automated installation activities might run into errors.

5.4.1 Deactivate Info Dialog Box on Dynpro Size Check

Use
The Sizing Conflicts dialog box may appear during activation and should be deactivated.

Procedure for GUI Version Below 720
1. Log on with the user in the system.
2. Choose the first pushbutton on the right of the standard toolbar (Customize Local Layout) or press ALT + F12.
3. Choose the Options menu item.
4. Choose the SAP Internal node.
5. Choose the SAP Internal page.
6. Deselect the Enable Dialog Box for Dynpro Size Check checkbox.
7. Choose the OK pushbutton at the bottom of the window.

Procedure for GUI Version 720
8. Log on with the user in the system.
9. Choose the first pushbutton on the side of the standard toolbar (Customize Local Layout) or press ALT + F12.
10. Select the SAP Internal node
11. Choose SAP Internal.
12. Deselect the Enable Dialog Box for Screen Size Check checkbox.
Choose the OK pushbutton at the bottom of the window.
5.4.2 SAP Software Change Registration (SSCR): Developer Key

**Use**
The user ID for activation has to be registered as a developer on SAP Service Marketplace (SAP Software Change Registration (SSCR)). For more information, see SAP Note [86161](http://service.sap.com/sscr). The SSCR developer key is required because the user ID for activating the SAP rapid-deployment solution content creates and changes objects from the customer name range during the activation process. If the SAP content activation user is not registered as a developer, the automated activation process encounters errors.

**Procedure**
2. On the SAP Software Change Registration (SSCR) start page, you get the detailed user documentation on how to proceed to get the SSCR developer key.

An SSCR developer key is a 20 character combination of digits that is queried when an SAP ERP user tries to create or change an object from the customer name range FOR THE FIRST TIME. The prompting message for the developer key appears once for each SAP ERP user; if registration is successful, this SAP ERP user is no longer prompted to enter a developer key. The SSCR developer key is generated from the installation number of the affected installation and the SAP ERP user name.

5.4.3 Unicode Settings

**Use**
Before each user logs on to the system for the first time, the user’s local GUI must be set to use the Unicode code page.

**Procedure**
1. From the SAP Logon pad, select your system ID.
2. Choose the Change Item button.
4. On the Encoding dropdown, select Unicode (UTF-8).
5. Choose OK.

5.4.4 Allow GUI Scripting

**Use**
Perform this activity so that eCATTs GUI scripts can be executed with your GUI.

**Procedure for GUI Version Below 720**
1. Choose the first pushbutton from the right side of the Standard Tool Bar Customizing of Local Layout or press **ALT + F12**.
2. Select the menu item Options.
3. Choose the Scripting tab.
4. Select the Enable scripting checkbox.
5. Deselect the checkboxes Notify When a Script Attaches to a Running GUI and Notify When a Script opens a Connection.

Choose the OK button at the bottom of the window.
**Procedure for GUI 720**

1. Choose the first pushbutton on the right of the standard toolbar (Customize Local Layout) or press **ALT + F12**.
2. Choose the **Options** menu item.
3. Choose the **Accessibility & Scripting** node.
4. Select the **Scripting** page.
5. Select the **Enable scripting** checkbox.
6. Deselect the **Notify When a Script Attaches to a Running GUI** and **Notify When a Script Opens a Connection** checkboxes. Choose the **OK** pushbutton at the bottom of the window.

---

### 5.4.5 Set Decimal Notation and Date Format

**Use**
Perform this activity to set up the activation user ID.

**Procedure**

1. Run the following activity:

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>System → User Profile → Own Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transaction Code</strong></td>
<td>SU3</td>
</tr>
</tbody>
</table>

2. Choose the **Defaults** tab.
3. Set the **Decimal Notation** according to your country's default, for example, 1,234,567.89.
4. Set the **Date Format** according to your country’s default, for example, MM/DD/YYYY.
5. Enter your printer in the **Output Device** field.
6. Save your settings.
7. Log off from the system.
8. Log on to the system.

   ![Warning Icon] Log off and log on is necessary since the change in the user settings only becomes effective when you log on to the system again.

9. You can change these values if necessary once the activation procedure has been completed.

**Result**
The decimal notation and date format have been set up according to your country format. The standard printer has been defined.

---

### 5.4.6 Allow Default Actions

**Use**
Allows the execution of the action this time and for all future occurrences. You will not be asked for this specific action again. This speeds up implementation although you may wish to re-set to the default setting of ‘Ask’ once the task has been completed.

**Procedure for GUI 720**

1. Choose the first pushbutton on the right of the standard toolbar (Customize Local Layout) or press **ALT + F12**.
2. Choose the Options menu item.
3. Choose the Security node.
4. Select the Security Settings page.
5. Select Allow as the value for Default Action.
6. Choose the OK pushbutton at the bottom of the window.

6 Implementation of Rapid-Deployment Solution Business Content

The following section describes the activities that have to be performed by the consultant activating the rapid-deployment solution business content in the system.

⚠️ Perform the steps Getting the Solution Scope File and Getting the Installation Data Files on the same day. If you download them at different times, you may encounter errors due to mismatching.

6.1 Select the SAP Solution Manager Template

Templates in SAP Solution Manager help you to carry out predefined implementation projects. The template specific to the SAP ERP rapid-deployment solution for employee and manager self-service contains the content for the 'default' implementation of the rapid-deployment solution. Familiarize yourself with the template by reading the template description at [http://service.sap.com/solutionpackages](http://service.sap.com/solutionpackages) → SAP ERP rapid-deployment solution for employee and manager self-service → Template.

Procedure

In this step, you create an implementation project to organize your work in the SAP Solution Manager (SOLAR_PROJECT_ADMIN).

To select the rapid-deployment solution within the implementation project, carry out the following steps in transaction

1. Go to the Scope tab page.
2. Selection of rapid-deployment solution
   a. In case of SAP Solution Manager 7.0 (ST 400) or SAP Solution Manager 7.1 (ST 710) < SP05
      i. Select the Template Selection sub-tab page using hyperlink for further information.
      ii. Search for the template **RDS_MESS_SP_XX_V01**
   b. In case of SAP Solution Manager 7.1 (ST 710) use (at least SP05)
      i. Select the Solution Package sub-tab page using hyperlink for further information.
      ii. Search for the Solution Package **SAP ERP Rapid Deployment Solution for employee and manager self-service_V2 (Please select the 1st occurrence of this package)**
Check that note 1687765 (Robomate) is implemented to see Solution Package sub-tab. But this is a mandatory step to be done within SAP Solution Manager 7.1 (ST 710) SP05 upgrade.

3. Save your project.

4. A dialog box for the mapping of the Logical Components appears. Adjust the chosen Logical Component via F4 help if needed. For more information, see chapter Checking the System Landscape in SAP Solution Manager.

5. Select the business scenarios you want to copy to your implementation project.

6. Save your project.

7. 

8. When you save your project for the first time, you need to specify the enhancement context in which the project documents are to be saved in Knowledge Warehouse.

9. Map the logical components assigned to the process steps of the selected business scenario to your current system landscape. The system identifies missing logical components for product versions/instances required for the business processes.

10. To add the logical components to your system landscape choose the Continue.

11. The list of logical components is updated on the System Landscape tab page.

12. Assign the systems in your system landscape to the logical components. For more information about the assigning logical components to a project see the SAP Help Portal at http://help.sap.com → Application Lifecycle Management → SAP Solution Manager → SAP Solution Manager 7.0 EHP1 SP26 → Implementing and Upgrading SAP Solutions → Project Administration → Create/Change Project → System Landscape Tab → Specify Project System Landscape → Assign Logical Components to the Project.

### 6.2 Adjust the Process Scope in SAP Solution Manager

In the following steps, you adjust the scope of the solution where possible to fit business goals, and adapt the configuration settings in the systems accordingly. In SAP Solution Manager, adjust the scope of the business processes you would like to implement.

From the SAP Easy Access menu, choose Business Blueprint (transaction SOLAR01). For more information on the rapid-deployment solution scope, refer to the Template Description.

All the business processes (scenarios) are self-contained in the template, that is, they all have related content assigned to them. This means that you do not have to choose Master Data or Organizational Unit nodes or Interface Scenarios in the blueprint structure. We recommend deselecting these nodes to obtain a clearer overview during the configuration step later (transaction SOLAR02).

In transaction SOLAR01, you can also access the template description to check which processes are mandatory or optional for the rapid-deployment solution. To access the template description, select the Templates column in the structure on the left. The system then displays the name of the template selected for the project in the structure (if the template name is not shown, scroll to the right until you can see the Templates column). By clicking on the template name displayed, you can access the template description.

6.3 Manual Implementation of the Content

Refer to the Building Block Configuration Guides for the activities and steps required to manually implement the rapid-deployment solution for employee and manager self-service. Due to technical constraints, there are certain steps that cannot be performed automatically. Therefore, it is essential to consult the configuration guides to ensure all necessary steps are performed.

6.4 Automated Implementation Using SAP Best Practices Solution Builder

Refer to the Building Block Configuration Guides to review the rapid-deployment solution content for this package that will be automatically implemented as a result of content activation.

6.4.1 Delivery of Automated Content

Content provided for the SAP ERP rapid-deployment solution for employee and manager self-service can be delivered in Solution Builder. To use the automated content provided by the rapid-deployment solution, refer to SAP Note 1674342, which contains detailed instructions on how to import it.

6.4.2 Create Installation Folder for Content Activation

Use

The scoping, personalization, and installation phase of Solution Builder require solution scope and installation data files to be stored in a specific folder on your hard drive or presentation server.

Procedure

Create an installation data folder on a server that can be accessed from within the SAP system where you want to install the SAP rapid-deployment solution content. Ensure that the person who will perform the installation has the necessary user rights to access this folder.

Perform the activities Getting the Solution Scope File and Getting the Installation Data Files on the same day. If you download them at different times, you may encounter errors due to mismatching.

6.4.3 Getting the Solution Scope File

Use

The technical structure for each solution package (processes or scope items, building blocks and technical objects) is managed by a solution scope file.
**Procedure**

2. Choose the **Solution files** link and then the link for **<EHP5 for SAP ERP 6.0>**.
3. Download the following solution scope .zip file and store it in the folder created in the section **Create Installation Folder for Content Activation** above.
   
   `<SOL RDS ESS MSS SP DP ERP605V2 BP ERP605Vx.zip>`

**6.4.4 Getting the Installation Data Files**

**Use**

The **installation settings** (configuration settings and master data) of the solution packages are managed by the installation data files.

**Procedure**

2. Choose the **Installation data file sets** link and then the link for **<EHP5 for SAP ERP 6.0>**.
3. Download the following installation data .zip file:
   
   `<INST_FILES_ESS_XX_BP_ERP605Vx.zip>`

4. Unpack the zip file containing the installation data files (*.txt files) to the folder created in the section **Create Installation Folder for Content Activation** above.

**6.4.5 Import the Solution Scope File to the SAP System**

**Use**

The relevant solution scope file (*.xml file) required for the SAP ERP rapid-deployment solution for employee and manager self-service has been copied to the installation data directory (as described in section **Create Installation Folder for Content Activation** above).

**Procedure**

To install the SAP ERP rapid-deployment solution for employee and manager self-service, upload the relevant solution scope file to the target SAP development system as follows:

1. Log on to the target SAP development system and start SAP Best Practices Solution Builder with transaction `/n/smb/bbi Solution Builder – Solution Editor`.
2. The **Solution Editor** screen appears and lists all the solutions available in the system.

   The solution list is empty the first time you start the Solution Editor (if no other users have imported or created solutions in the system).

   We recommend that you add the transaction for Solution Builder (/SMB/BBI) to your favorites in the SAP user menu.

3. On the **Solution Builder – Solution Editor** screen, choose **Solution → Import → Solution (XML)** from the navigation menu.
4. In the **Select the Solution Scope File (XML)** dialog box, specify the path to the installation directory, select the solution scope file RDS_ESS_MSS_SP_DP_ERP605.xml, and choose **Open**.
5. An information box is displayed if the solution was uploaded successfully (depending on the size of the solution, the upload can take from a few seconds to one minute). Choose OK to confirm.

Result
The uploaded solution is visible in the solution list. If it is the first solution you have imported, it is automatically marked as your ‘favorite’ solution. Otherwise, highlight the solution in the solution list and choose the Favorite pushbutton to set it as your favorite.

⚠️
If the path to the installation data directory is too long, the system will display an error message. If you receive this error message, either rename the directories in the path to shorten the file path, or copy the installation files to a directory closer to the root folder of the hard drive.

6.4.6 Upload Installation Data

Procedure
To upload the installation files, proceed as follows in Solution Builder:
1. Go to view Solution Builder – Solution Editor
2. From the navigation menu, choose Go to → Installation Data → Upload to open the Upload Installation Data window.
3. Select the Upload with single ZIP file checkbox.
4. Use the browser search in the Path field to locate and retrieve the zip file created in a previous step. Select Open to select it and return to the Upload Installation Data window.
5. Choose the Continue pushbutton.

⚠️
Perform the steps for retrieving the solution file and importing the scope and installation data files in the same day. If you download them at different times, you may encounter errors due to mismatches.

Result
A system message confirms that the installation data has been uploaded successfully to Solution Builder.

6.4.7 Set User Settings for Solution Builder

Use
This activity sets user settings, including the document path for information that may be useful during activation so that users can find details from the SAP Help Portal about the scenario being activated. The activation script requires this setting to be present in the system.

Procedure
1. From the SAP Best Practices Solution Builder – Solution Editor screen, choose Goto → User Settings to open the User Settings window.
2. In the Solution specific tab > Installation Data, use the drop-down search to locate the folder storing the activation files.
3. Choose the General tab and under Settings ensure the ‘Check Consistency with eCATT definitions during Installation Data upload’ check box is de-selected; under Relevant for
Migration … ensure the ‘Maintain references in eCATT definitions during Installation Data upload’ check box is selected.

4. Choose the External Documents tab.
5. Choose the Display <> Change toggle pushbutton to switch to Change mode.
6. Make the following entries:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DOCUMENTATION%</td>
<td><a href="http://help.sap.com/">http://help.sap.com/</a></td>
</tr>
</tbody>
</table>

7. Choose OK (Enter) to save your entries and return to the Solution Builder – Solution Editor screen.

### 6.4.8 Activate the Solution

#### Use

Solutions are implemented in the Implementation Assistant.

To activate a solution, the following information must be provided when prompted in the Activate Solution window (see Procedure below):

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution</td>
<td>Defaulted name of solution</td>
<td>Check solution name to be activated is correct, based on your selection</td>
</tr>
<tr>
<td>Target Language</td>
<td>EN</td>
<td>Target language (the language of text fields for system parameters that are not language-dependent in a technical sense; once the installation has been started, the target language cannot be changed). For this rapid-deployment solution, the target language should always be EN.</td>
</tr>
<tr>
<td>Supplemental Data</td>
<td>Location of the folder with installation data, for example, Z:\rds\files</td>
<td>This folder was created in the step Create Installation Folder for Content Activation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You cannot use UNC paths (for example, \dwdf030\SME...).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Always use a mapped network drive (for example, Z:\SME).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Root directories on your local drive (for example, C:) also cannot be used.</td>
</tr>
<tr>
<td>Workbench</td>
<td>Workbench request number</td>
<td>Leave blank – this will be created automatically during the solution activation process.</td>
</tr>
<tr>
<td>Customizing</td>
<td>Customizing request number</td>
<td>Leave blank – this will be created automatically during the solution activation process.</td>
</tr>
<tr>
<td>Create request</td>
<td>Select</td>
<td>This indicator ensures that associated workbench and Customizing requests are generated during the solution activation process.</td>
</tr>
<tr>
<td>With demo data</td>
<td>De-select</td>
<td>If this option is selected, the system executes activation steps that create sample data. If it is deselected, these steps are not executed. The selected option should, therefore, be relevant to the RDS package being installed &amp; this solution does not include demo data.</td>
</tr>
</tbody>
</table>
### Procedure

1. From the Solution Builder – Solution Editor screen, choose the Implementation pushbutton. Your imported solution scenarios and building blocks are displayed.

2. On the Implementation Assistant – Solution View screen, choose the Check pushbutton to ensure the selected files for activation are consistent; if unexpected errors occur, refer to the error handling section below.

3. On the Implementation Assistant – Solution View screen, choose the Activate pushbutton.

4. Specify the activation options in the Activate Solution window, as described in the table above.

5. Confirm the Activation dialog box.

### Result

Activation is started. Depending on the number of manual activities and possible errors during implementation, the activation process may stop occasionally and wait for manual input or troubleshooting.

💡 

Unnecessary interruptions during the content activation process can be minimized or avoided by ensuring that the user settings in the Section above have been defined correctly in advance.

### 6.4.9 Verify Web Dynpro ABAP eCATT Rendering Flag

#### Use

This flag must be set successfully to enable the running of eCATTs that facilitate the Web Dynpro ABAP configuration included in this rapid-deployment solution. Since the setting of this flag is critical to the solution activation process, a check has been built into the activation program. As it is possible customers may opt to implement only ESS or only MSS, the check has been incorporated into both pre-requisite building blocks for these scenarios. When the solution activation process is started (as described above), a system check will be made and the user will be prompted follow the procedure set out below.

#### Procedure

1. If the eCATT executed without any error, as determined from the log report in the bottom right-hand pane of your screen, please continue with the activation. You will need to acknowledge the verification step (see notes on manual intervention in the following section of this document).

2. If the eCATT executed but generated an error, you should proceed as follows with support from technical colleagues, as required.
   1. In the transaction NWBC, your URL for the SAP NetWeaver logon screen will be displayed as: 
      [https://<your_host>:<your_port>/nwbc/~launch/](https://<your_host>:<your_port>/nwbc/~launch/)
   2. Replace the path /nwbc/~launch/ in the given URL with: /sap/bc/webdynpro/sap/wd_global_setting and select Enter.
An example of transaction NWBC SAP NetWeaver logon screen URL is:
https://uxai1rd5.wdf.sap.corp:44375/nwbc/~launch/

After making the changes to the URL, an example of the URL is:
https://uxai1rd5.wdf.sap.corp:44375/sap/bc/webdynpro/sap/wd_global_setting

3. In the Cross-Application Settings for Web Dynpro ABAP screen, select Change.
4. In the Parameters section find ‘Permit eCatt Rendering (WDENABLEXBCMLCLIENT)’; select Reset.
5. Re-activate this parameter by selecting the checkbox.
6. Save your entry. After getting the message “Data saved successfully”, close the window and continue with your activation, following the guidelines in the section below.

6.4.10 Manual Interaction and Error Handling During Activation

Use
The installation procedures for the scenarios/building blocks contain manual installation steps and/or required manual confirmation of certain steps. Where manual intervention is required, the activation program will stop and a prompt will be generated. A dialog box will give you the option of navigating to the IMG or proceeding. Where appropriate, notes are provided in a separate window, generated by the Performance Assistant. Typically, such notes will refer you to the relevant configuration guide where fully detailed steps for performing the required task can be found. At such points, the content activation is suspended while you configure or carry out the relevant tasks. Once the task(s) is/are completed, you can return to the Solution Builder, acknowledge that the change was made, and proceed from step 6 below.

Certain steps for activating this rapid-deployment solution require eCATTs to be run manually. Should this be required, the activation program will call the transaction eCATT, where you need to enter the name of the eCATT and run it. The Performance Assistant pop-up window will guide you through this process with detailed notes. As per the configuration activities above, once the eCATT has run successfully, proceed again from step 6 below.

You might also need to respond to possible errors and/or system prompts. When activation of an automated task runs into errors, the process stops at the point at which the error occurred. No further implementation steps can be performed until the error/issue has been resolved.

Procedure
The following information is provided to help you resume content activation after suspension for manual steps, as well as to resolve problems that might occur during the installation process.

⚠️ Before you start analyzing and processing errors in detail as described below, proceed as follows:
Activate your solution or the respective scenario in the Solution Builder implementation assistant again. The error might not occur. In this case, no corrections are required and the installation proceeds as normal.

1. On the Implementation Assistant – Solution View screen, choose a task that has a red light in the Current Status column.
2. Expand the task and choose the log assigned to it.
Detailed information about the error is displayed in the Error List pane.
3. In the Error List pane, choose Display Detailed Log. The detailed log information about an eCATT or BC set activation is displayed.
4. In this log information, check entries with a red light to identify the reason for the error.
   - If the error can be resolved using the log information, you can run the eCATT or BC set again.
   - If the activation fails because of locked objects, make sure that no objects are locked by any users. Then try to activate the activity again.

5. If the log information is not sufficient to solve the problem:
   a. Execute the task manually: use the description of the related section in the configuration guide for executing the task,
   or
   b. Open a customer message for this problem specifying the component <specific component>.

   ! Error
   Do NOT delete Solution Builder scenarios after they have been activated. If you delete scenarios, the activation history and the respective logs are lost and finding the cause of errors is more difficult.

   SAP cannot provide support in this case.

6. Once you have solved the problem (either executed the task manually or received a solution via a customer message), choose the Change / Confirm manual step pushbutton that is displayed in the Old Status column to the right of the task.

   ! Error
   Do NOT proceed with installation if the problem has not been solved. If you continue without solving the problem, serious errors might result in the subsequent installation steps that can be extremely complex to resolve.

   SAP cannot provide support in this case.

7. Choose the Change pushbutton that is displayed in the Old Status column to the right of the task.

8. In the Confirmation dialog box, choose OK to manually change the status to successful.

9. In the Information dialog box, enter a reason for changing the status, if required.

10. Choose Continue.

   The information is saved in a log. To view details for a changed task, choose the red light in the Original Status column for the task. A dialog box displays the user who made the change, the date of the change, and the reason for the change. Choose Continue to close the dialog box.

11. Choose Activate to continue with the installation, as outlined in the section above.

   Depending on the solution scope being activated, you may need to repeat the above process a number of times until activation is completed.

   ! Error
   If you need to interrupt the activation process and perform activities elsewhere in the SAP system, you should close that session prior to resuming the content activation
process. To avoid errors, the content activation session should be the only current session.

**Result**
Once the activation process has been successfully completed, a confirmation system message is displayed. You will now be able to review the delivered configuration settings for the SAP ERP rapid-deployment solution for employee and manager self-service in the system.

### 6.4.11 Optional: Changing the Package for Workbench Objects
The defaulted package for workbench objects in this RDS is Z001. If there is a need to change this to a project specific package, like Y_SPRDS_ESS_MSS, you would need to make changes to the variant files downloaded from the SAP Note.

These changes are only necessary when you want to have the package changed.

Go to the folder on your harddrive mentioned in the previous chapter. Here you should find the extracted variant files you downloaded. Find and open the following file:

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMB99_ACTIVATION_PARM_DXX_J01.TXT</td>
</tr>
</tbody>
</table>

Find the following value

| I_DEVCLASS | Z001 |

Change the value to your specific package, in this example:

| I_DEVCLASS       | Y_SPRDS_ESS_MSS (Example) |

Make sure the changed value is correct and that package has been created correctly. If the value is not entered correctly or if the package is not existing, the activation of the solution will fail.

### 6.5 Uploading the Security Roles
The various Building Blocks in this rapid-deployment solution are delivered with tailored user roles. These roles contain the authorizations and menu options specific to this RDS. To upload the roles you will need to download them from the central RDS note:

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1674342</td>
<td>SAP ERP rapid-deployment solution for employee and manager self service</td>
<td>SV-RDS_HCM</td>
<td>General Info</td>
<td>Always check the SAP Note for SAP ERP rapid-deployment solution for the employee and manager self service for updates on the implementation.</td>
</tr>
</tbody>
</table>
1. Access the note and download the attachment SPRDS_ESS_MSS_SEC_ROLES.zip. Extract the file to a specified location on your hard drive.

2. Go to transaction PFCG to upload the roles:

<table>
<thead>
<tr>
<th>SAP Menu</th>
<th>Tools → Administration → User Maintenance → Role Administration → Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Code</td>
<td>PFCG</td>
</tr>
</tbody>
</table>

1. Select Role
2. Select Upload
3. Browse to the in step 1 specified location
4. Select the role needed
5. Select Ok
6. Repeat the procedure for roles needed.